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1
Program Overview

This chapter provides you with a brief overview of Greeting Card
Maker’ terms and interface.

Welcome to Expert’s Greeting Card Maker!
Create your own personalized greeting cards with Expert's Greeting Card Maker!  This program gives you all
the tools you need to create great cards - custom artwork, professionally written sentiments, and a simple to
use interface that will make your creative work a snap. If you are in a hurry, we have included a collection of
ready-made templates for many different occasions. Simply choose the occasion, select a design, add your
personalized information, and print your card out in minutes. Or, if you are more creatively inclined, the pro-
gram features a powerful set of tools, layout features, and content which you can mix and match to create your
own card designs. Whatever the occasion and whatever your creative talents, Expert Greeting Card Maker is
the perfect tool for creating the perfect card.

Great Features
Expert Greeting Card Maker contains many useful features for creating great greeting cards:

Choose from our collection of professionally written sentiments for dozens of occasions. Want to write your
own greetings?  Expert Greeting Card Maker features the Zillion Kajillion Rhymes TM dictionary to help you
find rhymes for over 10,000 words. A built in Thesaurus and Spell checker makes sure you find the right word -
every time. Artwork?  Expert Greeting Card Maker comes with hundreds of quality illustrations you can use in
your cards, including 100 color clipart images from Imageline, Inc. And when it comes to printing, Expert
Greeting Card Maker lets you print on regular 8 1/2" x 11" paper, or for a more professional look, on pre-printed
card stock from Fintech.
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Terms/Definitions
Click Press and release the mouse button (usually the left mouse button unless otherwise specified).

Double-Click Quickly press and release the mouse button twice.

Choose Highlight an item on the menu or dialog box to initiate an action or command, then press the Enter
key or double-click your left mouse button.

Enter Press the Enter or Return key.

Select Mark or choose an item so that the next action or command is carried out on that item. Highlight an
option or choice from the menu or design document by clicking on it.

Drag and Drop Press and hold the mouse button and the shift key down while dragging the mouse. This
allows you to move selected objects.

Border The line along the outside of an object.

Choose File—Open Choose a command from the applicable menu item. In this case, the command means to
go to the File menu and select the Open command.

Control Menu Box The hyphen-shaped icon at the top left of the title bar of any window.

Ctrl+Click Pressing and releasing the mouse button quickly while holding the control key on the keyboard.

Handles Small squares that appear on an object's perimeter when it is selected. By dragging the handles, you
may re-size objects.

Object In the Card Editor Screen Object can refer to any item that can be selected and edited. There are
Text Objects and Picture Objects. All Objects can be reduced, enlarged, and rotated.

Shift+Click Press and hold the mouse button and shift key down, while dragging the mouse. This allows you to
move selected objects all at once.
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Choosing a Card Project 
This is the first screen you see
upon entering Expert’s Greeting
Card Maker:

1. Choose From Ready-Made Cards button - Click here to choose ready-made card designs from the Card
Rack screen.
2. Construct Your Own Card button  - Click here to go to the Card Editor Screen where you can create your
own cards.
3. Open Card You Have Saved button - Click here to open cards you have previously saved.
4. Close button - Click here to abandon the selection and exit the program.
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Main Interface
This screen appears after making your selections. This is the Main Interface of the program:
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1. Card Editor Screen - This is the screen where you can customize and edit your card designs. Layout tools
such as rulers, alignment options, and font editing are available here, including toolbars for adding clipart and
for changing card backgrounds.

2. Menu Commands - Use the menu commands to access all of the Card Editor Screen's features through the
keyboard.

3. Left Toolbar - This toolbar contains the main editing functions available in the program. Buttons included
are: zoom in/zoom out functions, add text, shape text, signature, and sentiments, select objects, align objects,
and draw order.

4. Clipart Bar - This toolbar has two uses. The first is to display the clipart which you can drag-and-drop into
your card. The second is to display printable card backgrounds and pre-printed card designs from different
card manufacturers.

5. Status Bar - Look here for important information about the current card design being worked on, including
card project type, card dimensions, and card background selected.

6. Navigator Bar - Use the buttons on this floating toolbar to view the outside and inside panels of the card,
including the envelope.
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2
Tutorial

Read this section to learn how to design your greeting
card quickly.

Tutorial Overview
I. Creating a Sample Card

II. Types of Cards
1. Printable Cards

a. quarter fold
b. half fold
c. blank card stock

2. Pre-Printed Cards
a. ordering cards

3. Envelopes

III. Using Ready Made Designs
1. The Card Rack

IV. Constructing and Editing Your Own Cards
1. Layout Editor Basics

a. layout editor

2. Working with images
a. toolbar

1. clipart, importing
2. backgrounds
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b. symbols

3. Working with text
a. Insert Text
b. Format Text
c. Edit Text (Text Editor Screen)
d. Spell Check, Synonyms, Antonyms, Rhymes
e. Adding Sentiments

4. Using the Card Editor Screen 
a. Viewing Tools
b. Selection Tools
c. Object Alignment Tools
d. Draw Order
e. Special Layout Tools

5. Card Setup
a. Card sizes

6. Preferences

V. Printing
1. Configuring Your Printer
2. Printing on Regular Paper
3. Printing on Pre-Printed Card Stock
4. Print Alignment

VI. Folding Cards
1. Folding Quarter Fold Portrait Cards
2. Folding Quarter Fold Landscape Cards
3. Folding Half Fold Portrait Cards
4. Folding Half Fold Landscape Cards
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I. Creating a Sample Card
In this section, we create a sample card in order to introduce you to the most common features and controls in
Greeting Card Maker. We create a Quarter Fold Card, customize it in the Card Editor Screen by adding our
own text and graphics, and finally print it.

1. Start the Greeting Card Maker program.

2. Click on the Construct Your Own Card button.
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3. Select the Quarter Fold - Portrait button.

A blank card now appears on the Card Editor Screen . We are now ready to begin constructing our design.
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4. First, lets select the card’s background art. On the Clipart Bar , click on the Card Backgrounds Mode but-
ton.

5. Choose a background image from the Clipart Bar and drag-and-drop it onto the card workspace.
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6. Now  lets add our own text to the card. Double click on the text object that reads "Sentiment 1". In the Text
Editor , type "Santa Says…"
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7. Single click on the text to highlight it. Change the font to "Bubblesoft" from the top toolbar control, and click
on the Center Justify button. Now re-size the text to a larger size by using the object handles.

8. Now, lets open the card to type our sentiment on the inside panel. Using the Navigator bar, click on the
Inside button.
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You should now see the inside panels of the card.

9. Change the text of the text object that reads "Sentiment 2" to "Merry Christmas!" and re-size it in the same
way as before.

10. On the Clipart Bar, click on the Clipart Mode button to switch modes so we can add clipart to our card.
Select any image and drag-and-drop it onto your card.

11. We have now constructed a basic Quarter Fold Portrait Card. Our next step is to print it. Click on the
Print button on the Top Toolbar . Make sure your printer configurations are correct, and if they are, click on
OK. Note : Quarter Fold cards print out on only one side of the paper. Half Fold cards and Pre-Printed Card
Stock require two-sided printing.
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12. Now that we have our design printed on a full sheet of regular paper, we need to fold it in quarters (hence
the name Quarter Fold). Holding the page upright, fold the upper half of the page backwards as shown:

Then, fold the bottom half as shown:

And that’s it! You have created your first card using Greeting Card Maker!
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II. Types of Cards
Expert Greeting Card Maker lets you create and print greeting cards on a variety of different papers, sizes, and
pre-printed card stock. Below is an overview of the different kinds of card types available in the program. By
choosing the card type when you begin a project, the dimensions and margins are set for the particular card.

Printab le Designs
"Printable" designs are those cards that you can print out on regular 8 1/2" x 11" paper, or on blank card stock.

Quarter fold - Also referred to as "french fold", this card is printed on a 8 1/2" x 11" paper and is folded into
quarters. Quarter fold cards can be made in portrait or landscape orientations.

Half Fold - This card is also printed on a 8 1/2" x 11" paper and is folded in half. This type of card requires
printing on both sides of the page. Half folds can also be made in portrait or landscape orientations.

Blank card stock - Blank card stock in different sizes can be used to print out your cards for a more "card
shop" look. You can purchase blank stock cards directly from Hudson River Works. The size of the cards will
be automatically set in the program when you select this option.

Pre-Printed Car ds
Greeting Card Maker supports a collection of card designs from several leading manufacturers. You can pre-
view each design directly on the screen, however, keep in mind that you cannot print the card’s artwork, only
the text and graphics that you add.

Ordering Cards - The status bar displays the manufacturer and item number for each card with which you can
purchase the cards directly through an 800 phone number. Once you receive your cards in the mail you can
feed them through your printer and print your own customized greetings on the inside. The card dimensions,
designs, and blank areas will be automatically set by the program.

Envelopes
Greeting Card Maker allows you to print out designs on envelopes too, including sender and return addresses.
You can double-click on the fields for the return address and sender, then type in your information in the Edit
Text dialog box. If your envelopes are not the default size (see the status bar for dimensions) you must enter
the proper dimensions in the Card Setup menu.
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III. Using Ready Made Designs
Card Rack screen is where you can browse through the hundreds of ready-made printable card designs avail-
able in Greeting Card Maker.
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Using the Card Rack Screen - First, select the occasion for your card by clicking on one of the tabs. A collec-
tion of thumbnails will appear showing the available ready-made templates. Double click on a thumbnail to see
a full-size preview of the card, including the inside of the card.

Use this list box to switch between Everyday occasions (birthdays, graduation, etc.) and Holiday occasions
(Christmas, Halloween, etc.). The tab names change to reflect the new occasion.

Click on the Open button to view the inside panels of the card, or double-click on the card itself. Click on the
Close button to close the card preview, and OK to return to the Card Rack . To select a card, click on it once to
highlight it, then click on the Select button.
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IV. Constructing and Editing Your Own Cards
Layout Editor Basics

Card
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Editor Screen - This is the screen where you can customize and edit your card designs. Layout tools such as
rulers, alignment options, and font editing are available here, including toolbars for adding clipart and for chang-
ing card backgrounds.

Menu Commands - Use the menu commands to access all of the Card Editor Screen's features through the
keyboard.

Left Toolbar - This toolbar contains the main editing functions available in the program. Buttons included are:
zoom in/zoom out functions, add text, shape text, signature, and sentiments, select objects, align objects, and
draw order.

Clipart Bar - This toolbar has two uses. The first is to display the clipart which you can drag-and-drop into
your card. The second is to display printable card artwork and pre-printed card designs from different card
manufacturers.

Status Bar - Look here for important information about the current card design being worked on, including
card project type, card dimensions, and card background selected.

Navigator Bar - Use the buttons on this floating toolbar to view the outside and inside panels of the card,
including the envelope.

Working with Ima ges
The Clipart Bar
The Clipart Bar in the Card Editor Screen serves as a palette for clipart and artwork where you can scroll
through the available images and drag and drop your selections directly onto your card design.

The Clipart Bar has two modes - Clipart Mode and Card Backgrounds Mode . You can toggle between
these two modes using the buttons at the top of the Clipart Bar.
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Clipart Mode

In Clipart Mode you will see color clipart available in the program's clipart directory. You can scroll through all
the images. To insert an image into your design, simply drag-and-drop it from the toolbar to your card.
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Importing Images 

To import images into your card design, click on the Browse button on the Clipart Bar . Greeting Card Maker
can import graphic images in the most popular file formats including .BMP, .PCX, .TIF, .GIF, .JPG, and more.

Note: If you import an image that is 256 colors or more, you may experience a color shift on the screen if you
are running Windows in 256 color or less. We recommend you run Windows in 16-bit color or higher for best
results with Greeting Card Maker.
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Card Background Mode

In Card Backgrounds Mode , you see a selection of card background artwork and pre-
printed card designs. If you have selected any of the ready-made templates or construct
your own card projects, the Clipart Bar shows card background art which you can select
and print on your cards. If you have selected a pre-printed stock project, the Clipart Bar
displays a number of card designs for cards that you can order from the manufacturer. you
are not able to print these designs out as they are included only as a design aid.

The printable designs shown under this selection can be printed out by the program. To
choose a background, simply drag-and-drop it onto your card project.

Pre-Printed Card Designs
Greeting Card Maker lets you view a collection of pre-printed card designs.

You can purchase the cards directly from the manufacturer. The card design that is dis-
played on the screen has the same dimensions, graphics, margins, and blank areas as the
real card. When you receive your cards through the mail, simply insert them into your print-
er and your greetings will print on them just as they are displayed on the screen.

Ordering Cards
Click on the Order Cards button to see ordering information and phone number the manu-
facturer. See Appendix A for more information.
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Using Signature Symbols
Greeting Card Maker lets you create, save, and re-use your own custom "signature symbols". These symbols
are also referred to as "colophons" and are usually found on the back panel of greeting cards.

Creating a Signature Symbol
Your Signature Symbol can be any combination of clipart, text, and fonts you wish. Simply select all the
objects that are part of the Signature Symbol, then Group them by using the Group option in the Edit menu.

Inserting a Signature Symbol
You can insert a saved Signature Symbol by clicking on the Insert Signature Symbol button on the left tool-
bar.
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Working with te xt
Greeting Card Maker gives you many options for entering, editing and formatting text.

Formatting Text
You can use the buttons on the Top Toolbar to change the font type, size, color and justification.

Inserting Text
Use the Insert Text button on the Left Toolbar to insert text into your card.

Editing Text
You can edit the text in any text object by double clicking on it. Doing so brings up the Edit Text dialog box
which contains several additional features.
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Spell Check button - Click here to perform a spell check of the current text. If a word is misspelled, a dialog
box appears with suggestions for the correct spelling of the word.

Synonyms button - The built-in thesaurus feature allows you to look up words of similar meaning to the high-
lighted word.

To use this, highlight the word you wish to look up, then click on the Synonyms button. A list of words appears
in the list box on the right. Choose the word you want, then click on the Copy button on the left.

Antonyms button - This works the same as the Synonyms button, but instead displays words of opposite
meaning to the highlighted word.

Rhyme Dictionary button - You can use the rhyme dictionary to look up words that rhyme, or have the same
ending sounds as the highlighted word.

To use this, highlight a word with the mouse, then click on the Rhyme Dictionary button. A list of words
appears in the list box on the right. Choose the word you want, then click on the Copy button on the left.
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Special Text Effects
You can apply a number of different special effects to your text using the Text Effects dialog box by clicking on
the Text Effects button on the Top Toolbar .

The following special effects are available:

Color Fill - Use this feature to "color in" your text. You can choose from four different fill styles: solid, gradient,
radial, and conical. For all the fill styles, with the exception of solid fill, you must choose a beginning color and
an ending color for the fill pattern.

Shadow - Displays a "shadow" effect to give the text a "3-D" look. You can choose the position and color of
the shadow, including the distance.

Background - This option allows you to color in the background of a text object.
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Shape Text

You can use the Shape Text feature to display text which can be warped into a number of different shapes.
You can use all the Special Text Effects on Shape Text .

Adding Shape Text - You can add Shape Text to your design by clicking on the Insert Shape Text button on
the Left Toolbar .

Editing Shape Text - You can edit Shape Text by double-clicking on it, just like regular text..

Choosing Shapes - You can choose the shapes for Shape Text by clicking on the Special Text Effects button
on the Top Toolbar with a Shape Text object selected.
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Sentiments
Greeting Card Maker has a collection of hundreds of sentiments for many occasions. You can scroll through
these sentiments, and add them to your card at any time.

Adding Sentiments

Click on the Insert Sentiment button on the Left Toolbar .
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Editing Sentiments

You can edit any sentiment in the same way as regular text by double-clicking on it.

Using the Car d Editor Screen
Working with Layout Tools
Greeting Card Maker features a number of tools and features to assist you in creating your greeting card
designs.

Viewing Tools

Navigator Bar

You can use the Navigator Bar to switch between the different card views - Front of Card, Inside of Card,
Outside of Card, and Envelope.

Zoom In/Zoom Out

You can use the Zoom In/Zoom Out tool to change the magnification of your current work area.
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Selection Tools

Clicking on the Selection button reveals the following buttons.

Select All Text button - Use this button to select all text objects in your layout. This is useful when you want to
change the font properties for all of your text at one time.

Select All Objects button - Use this button to select all objects - text, logos, and clipart.

Group button - When you have two or more objects selected, use this button to combine them into a single
"object."

Ungroup button - Use this button to dismantle a grouped object into its separate components.

Object Alignment Tools

Use the Align Objects buttons to line up objects.

Align Left button - When a single object is selected, it aligns it to the left-most paper margin. When two or
more objects are selected, they are both aligned along their respective left margins.

Align Right button - Aligns a single object to the right paper margin and aligns multiple objects along the right
margins.

Align Top button - Aligns a single object to the top paper margin and aligns multiple objects along the top
margins.
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Align Bottom button - Aligns a single object to the bottom paper margin and aligns multiple objects along the
bottom margins.

Center Vertically button - When a single object is selected, it is centered vertically on the page. When two or
more objects are selected, they are centered vertically in relation to each other.

Center Horizontally button - When a single object is selected, it is centered horizontally on the page. When
two or more objects are selected, they are centered horizontally in relation to each other.

Center on Page button - Places single or multiple objects in the center of the current page.

Draw Order Buttons

Bring Object To Front button - Brings the selected object to the front.

Send Object To Back button - Sends the selected object to the back.
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Special Layout Tools

Greeting Card Maker features visual aids to assist you in creating layout designs. These include rulers, paper
margins, guidelines, snap to grids, and visible object shapes. All of these items can be turned on or off through
the View menu on the top toolbar, or specific settings can be found for these in the Preferences option in the
File menu.

Rulers

The Rulers in Greeting Card Maker show you the dimensions of the current card panel you are working on,
and can serve as a handy guide when arranging text or graphics on the screen. The two "tick" marks that
appear when you select an object show you the length and the width of the object you have selected. You can

turn Rulers on or off
through the View menu.

Guidelines

You can activate Guidelines by clicking on either of the rulers, holding down the left mouse button and dragging
the guideline.You can place guidelines anywhere on the page horizontally, as well as vertically. Once the guide-
line is in place, you can move objects toward it. When the object is within several pixels, the guideline becomes
"sticky." In other words, it causes the object to attach itself to it. Guidelines are useful for aligning several
objects along a specific position on a page.You can reposition a guideline by dragging it. To remove a guide-
line, drag it back behind the rulers. An Add Guidelines at Margins function exists in the Format menu. It auto-

matically places guide-
lines exactly on the
paper margins.

Greet.qxd  11/22/96 1:53 PM  Page 37



Grids

The Snap to Grid feature sets up a series of points at set intervals that are "sticky" in the same manner as
guide-lines.You can move objects and "snap" them to these points. This is useful when you want to layout sev-
eral objects at precise locations. The Snap to Grid option can be turned on/off through the Preferences option
in the File menu. The intervals for the grid can be set in intervals of 1/16" and can also be set through the
Preferences option.

Status Bar

The Status Bar displays important information about the current card, including card dimensions, card type,
background, manufacturer and item number for pre-printed card designs.
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Card Setup
The Card Setup dialog box lets you enter the dimensions of the card or envelope for printing. Choose Format
Menu—Card Setup .
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Program Pref erences
You can set program options for Greeting Card Maker through the Preferences dialog box.

Pull down the desktop color button to set the preferred color of your desktop while you work, set your preferred
unit of measurement, and choose to snap drawn lines or objects to the grid.
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V. Printing
Configuring the Pr ogram to Work with Your Printer

Printing on pre-printed stock cards requires that you correctly feed cards into your printer. The purpose of the
Configure Print dialog box is to setup the program with settings for your particular printer, including manual
feed operations.

You will need to run the configuration procedure if you intend to print cards on blank stock or on pre-printed
cards. This way the program will know where to print correctly on paper sizes smaller than regular paper.

When you run the Print Configuration routine, you should not have to use your printer’s setup options, such as
landscape or portrait settings. These will be set automatically by the program. Changing any of these settings
yourself may cause the cards to be printed incorrectly.

When you select the Printer Configuration option from the File menu, the following dialog box will appear. In
order to properly setup your printer, follow each of the steps described:

Greet.qxd  11/22/96 1:53 PM  Page 41



1. Whic h way do y ou f eed paper into y our printer?
Most home printers today have the paper feed tray either on the front or on the back. Select the option that
matches your printer.

2. Whic h side of the f eed tray do y ou align the paper to?
Printers usually require that you align paper to a certain side on the paper feed tray. Some printers have a slid-
ing paper guide for feeding paper that is not standard size or for envelopes. Choose which side your need to
align to on your paper feed tray.

3.  For man ual f eed, whic h way does the paper face?
When you do a manual feed, does your printer require that you place the paper face up or face down?

4.  Perform Print Test 1
The first print test prints "Top of Page" on a regular sheet of paper. This will serve as a reference guide for
determining how your printer prints items in landscape mode.

When you have done Print Test 1, click on the Next button to proceed to the next series of configuration steps.
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Printing on Regular P aper
For Printing Quarter Fold cards, you do not need to do anything special with your printer as the entire card will
print out on regular paper and on the same side of the page.

Half Fold cards require that you turn the paper over and feed it again through your printer. You need to run the
Print Configuration option in the File menu, so that the program knows how your particular printer works with
manual feed. When you print a Half Fold card, the Print dialog box will instruct you on how to orient your paper
as you feed it into your feed tray.

Printing on Blank Car d Stoc k
Printing on Blank Card stock requires that you have previously run the Print Configuration option in the File
menu and that the program is correctly configured to work with your printer.

When you print on Blank Card stock, a dialog box will appear with instructions for feeding the card into your
printer’s feed tray.
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The program will print out the Outside panels of the card first, then ask you to turn the card over and insert it
into the paper feed tray again in order to print out the Inside panels. Follow the instructions on the screen. If
your card does not appear to print correctly, run the Print Configuration option again and verify that your set-
tings are correct. If your print-outs appear off-center or print outside the card boundaries, you can use the Print
Align feature in the File menu. You can use the arrow keys to manually nudge the design in the desired direc-
tion.

Printing on Pre-Printed Car d Stoc k
Printing on Pre-Printed card stock requires that you have previously run the Print Configuration option in the
File menu and that the program is correctly configured to work with your printer. Please note that the design
you see on the screen is for layout purposes only and will not print out on a Pre-Printed card, only the text and
graphics you have added to it.

When you print on Pre-Printed card stock, a dialog box will appear with instructions for feeding the card into
your printer’s feed tray.
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The program will print out the Outside panels of the card first, then ask you to turn the card over and insert it
into the paper feed tray again in order to print the Inside panels. Follow the instructions on the screen. If your
card does not appear to print correctly, run the Print Configuration option again and verify that your settings
are correct.

If your print-outs appear off-center or print outside the card boundaries, you can use the Print Align feature in
the File menu. You can use the arrow keys to manually nudge the design in the desired direction.

Printing En velopes
Printing envelopes in Greeting Card Maker is very similar to printing cards. In order to get the best results you
must enter the exact size of your envelope in the Card Setup dialog box in the Format menu. Once you have
entered the size, all you need to do is feed the envelope into your printer as shown and print.

Very Important!  Most printers have a special way of feeding and printing envelopes built in, however this only
works for standard size envelopes (size 10, etc.). Feed your envelopes into the feeder tray like shown in the
Print diagram, not like you usually feed them into your printer.
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Sample Envelope feeding instructions. The diagram will show you the orientation specific to your printer.

Print Alignment
In the event that your cards don’t print out correctly try the Print Align function. Located in the File/Print Align
menu, you can manually shift the card in the direction you want to align it in. A graphic displays the amount
that you are nudging your design over.
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VI Folding Cards
Folding is the last step in constructing your own greeting cards. Each type of printable card - Quarter Fold
Portrait, Quarter Fold Landscape, Half Fold Portrait, and Half Fold Landscape - has its own folding method.

Folding Quar ter Fold P or trait Car ds
Quarter Fold cards, as the name implies, are folded in quarters. All four sides of the card are printed on the
same side of the page as shown below:

Step 1. Hold the page in front of you as shown below.

Step 2. Fold the top half of the page backwards, as shown.

Step 3. Fold the left quarter of the card back, as
shown.
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Folding Quar ter Fold Landscape Car ds
Quarter Fold cards, as the name implies, are folded in quarters. All four sides of the card are printed on the
same side of the page as shown below:

Step 1. Hold the page in front of you as shown below.

Step 2. Fold the top half of the page backwards, as shown.

Step 3. Fold the left quarter of the card back, as shown.
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Folding Half Fold P or trait Car ds
Half Fold cards, as the name implies, are folded in half. Half Fold Portrait cards will print designs on both sides
of a page.

Step 1. Hold the page in front of you as shown above.

Step 2. Fold the left half of the page backwards, as shown.
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Folding Half Fold Landscape Car ds
Half Fold cards, as the name implies, are folded in half. Half Fold Landscape cards will print designs on both
sides of a page. The front side of the page should look like this:

Step 1. Hold the page in front of you as shown below.

Step 2. Fold the top half of the page backwards, as shown.
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3
Tools/Toolbars

This chapter describes the tools and toolbars resident
in the Greeting Card Maker program.

Main Toolbar

New Card button
Click on this button, or choose FIle Menu—New Card , to create a new card.
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Open Car d button
Click on this button, or choose FIle Menu—Open Card , to open a previously saved card. The Open Card dia-
log box appears:

Select the drive where you have saved the card, highlight the desired card and click on the OK button, or dou-
ble-click on it..
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Save Current Car d button
Click on this button to save the current card. The Save As dialog box appears:

Print b utton
Select this button, or choose File Menu—Print to launch the print screen.

Cut button
Click on this button, or choose File Menu—Cut to delete selected text to be pasted somewhere else in the
card.

Copy button
This button is used to copy selected text into another section.You can also choose File Menu—Copy.
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Paste button
Click on this button, or choose FIle Menu—Paste , to paste selected text to new place in the card.

Undo b utton
Click on this button, or choose File Menu—Undo , to undo the last executed command.

Font b utton
Click on this button to choose a font.

Font Siz e button
Click on this button to change the font size.

Font Color b utton
Click on the Font Color button to set the color of the selected text font.

Underline b utton
Use this button to underline selected text.

Bold b utton
This button is used to bold selected text.

Italics b utton
Click on this button to italicize selected text.

Text Left Align b utton
Use this button to align text to the left margin.

Text Center Align b utton
This button centers selected text.

Text Right Align b utton
Use this button to align text to the right margin.
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Text Eff ects b utton
Click on this button to set the effects of your text. The Text Effects dialog box appears:

Help button
This button calls up the on-line help manual.
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Selection Tools
Pressing the Selection button reveals the following buttons.

Select All Text button
Use this button to select all text objects in your layout. This is useful when you want to change the font proper-
ties for all of your text at one time.

Select All Objects b utton
Use this button to select all objects - text, logos, and clipart.

Group b utton
When you have two or more objects selected, use this button to combine them into a single "object."

Ungroup b utton
Use this button to dismantle a grouped object into its separate components.
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Object Alignment Tools
Use the Align Objects buttons to line up objects.

Align Left b utton
When a single object is selected, it aligns it to the leftmost paper margin. When two or more objects are 
selected, they are both aligned along their respective left margins.

Align Right b utton
Aligns a single object to the right paper margin and aligns multiple objects along the right margins.

Align Top button
Aligns a single object to the top paper margin and aligns multiple objects along the top mar-gins.

Align Bottom b utton
Aligns a single object to the bottom paper margin and aligns multiple objects along the bottom margins.

Center Verticall y button
When a single object is selected, it is centered vertically on the page. When two or more objects are selected,
they are centered vertically in relation to each other.

Center Horizontall y button
When a single object is selected, it is centered horizontally on the page. When two or more objects are select-
ed, they are centered horizontally in relation to each other.

Center on P age button
Places single or multiple objects in the center of the current page.
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Draw Order Buttons

Bring Object To Front b utton
Brings the selected object to the front.

Send Object To Back button
Sends the selected object to the back.
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Left Toolbar

Zoom In b utton

Use this tool to magnify the viewing area.

Zoom Out b utton

Use this tool to maximize the viewing area.

Inser t Text button

Inserts a text object that can be edited.
Inser t Shape Text button
Inserts a text objects that can be shaped.

Sentiments b utton

Use this button to insert sentiments.

Inser t Symbol b utton

Inserts a logo from the logo directory.

Object Selection b utton

Select All, Select Text, Group, Ungroup

Object Alignment Contr ols

Use this button to control selection and alignment functions.
Draw Order button
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Navigator Bar

Front of Car d
Click here to display the front panel of the greeting card

Inside of Car d
Click here to display the inside panels of the greeting card

Back of Car d
Click here to display the back panel of the greeting card.

Envelope
Click here to display the envelope.
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4
Menus

Read this chapter for a complete understanding of
Greeting Card Maker’s menus and corresponding
options.

File Menu

The File menu enables you to create new cards, open existing cards,
save cards, and deal with printing issues.

New Card (Ctrl - N)

This option returns to the Main Screen where you can select a new pro-
ject type.You can also click on the New button.
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Open Car d (Ctrl - O)
Choose File Menu—Open Card , or click on the Open Card button, to open a previously saved project file. The
Open dialog box appears:

Click on the drive where you have stored previously saved cards, highlight the desired file and click on the OK
button or double-click on the desired file.
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Save (Ctrl - S)
Use this option, or click on the Save button, to save the current card to disk. The Save As dialog box appears:

Click on the drive you wish to save the card to, type in a name if the card is a brand new file, and click on the
OK button.

Save As (Ctrl - P)
This option saves the current card to disk under a different name. The Save As dialog box appears as above.
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Print
Choose File Menu—Print or click on the Print button to send the current card to the printer.
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Print Setup
Allows you to change your printer settings. The Print Setup dialog box appears:
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Print Configuration
Choose File Menu—Print Configuration to configure Greeting Card Maker to work with your printer.
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Print Align
Lets you fine-tune your printouts for accurate printing.
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Preferences
Use this option to change your user preferences for Greeting Card Maker.

Files
This area displays the previously opened and/or modified project files.

Exit
Use this option to quit Greeting Card Maker. This confirmation dialog box appears, verifying that you wish to
exit the program. Click on Yes to exit the program, No to continue working on a card.
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Edit Menu
The Edit menu provides options that let you undo your last operation, cut, copy and
paste items to and from the clipboard, delete and duplicate items, select all text, and
group items.

Undo (Ctrl - Z)
Choose Edit Menu—Undo , or click on the Undo button, to cancel the last operation
performed and restores the file to its previous state.

Cut (Ctrl -X)
Use this option, or the Cut button, to place the selected object in the program’s clip-
board.

Copy (Ctrl - C)
Use this option, or the Copy button, to place a copy of the selected object in the pro-
gram’s clipboard.

Paste (Ctrl - V)
Choose Edit Menu—Paste or click on the Paste button to put an object stored in the

clipboard on the document.

Delete (Ctrl - DEL)
This option deletes the selected object.

Duplicate
Use Duplicate to make a duplicate copy of the selected object.

Select All Text (Ctrl - T)
Choose Edit Menu—Select All Text to select all text objects. This is useful when changing fonts and text
styles.

Select All Objects (Ctrl -A)
This option is used to select all objects.
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Group (Ctrl - G)
Use Group to combine all selected objects into one single object.

Ungroup (Ctrl - U)
Choose Edit Menu—Ungroup to break up a grouped object into its component parts.

Save as Symbol
This option saves a grouped object as a Symbol object (.sym) for later retrieval.
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View Menu
The View menu enables you to either view or hide the rulers, status
bar, the various toolbars, grids and guidelines. A checkmark next to the
option indicates that the option is active.

Ruler s
Choose View Menu—Rulers to turn the display of Rulers on/off.

Status Bar
This option turns the display of the Status Bar on/off.

Clipar t Bar
Use this option to turn the display of the Clipart bar on/off.

Navigator Bar
Choose View Menu—Navigator Bar to turn the display of the
Navigator bar on/off.

Guidelines
This option turns the display of Guidelines on/off.

Margins 
Use this option to turn the display of Paper Margins on/off.

Grids
Choose View Menu—Grids to turn the display of Snap to Grids on/off.

Object Outlines 
This option turns the display of Object Outlines on/off.

Background 
Use this option to turn the display of the Background on/off.
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Refresh Screen
This option re-draws the screen contents.

Zoom
This option changes the magnification of the screen.

Insert Menu
The Insert menu enables you to insert and shape text, insert clip art and logos.

Text 
Inserts Text into the project.

Shape Text 
Inserts a Shaped Text object into the project.

Clip-Ar t 
Inserts a Clipart object into the project.

Symbol
Inserts a Symbol object into the project.
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Format Menu
The Format menu lets you set font attributes, text effects, and set layers and alignment.

Font
Choose Format Menu—Font to set font attributes for the selected text.
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Text Eff ects
This option lets you set Headline text, drop-shadows, fills, and background color This dialog box appears, offer-
ing you several tabs to click on and set the desired effects:

Note: Text Effects are only available in Windows™ 95.
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Center 
Choose Format Menu—Center to center text horizontally or vertically on the page.

Align 
This option controls object alignment - left, right, top, bottom, center.

Draw Order
Choosing Format Menu—Draw Order lets you control object layer position - bring to top, send to bottom.

Add Guidelines at Mar gins
Choose Format Menu—Add Guidelines at Margins to automatically set guidelines at the paper margins.

Remove All Guidelines
This option removes all guidelines.

Card Panel
This option lets you select the card panel you wish to view: letterhead, env., bus card, fax.
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Help Menu
The Help menu provides access to the online help file and program copyright information.

Index
Choose Help Menu—Index brings up the Greeting Card Maker help file.

Using Help
This option brings up the Microsoft Help engine 

About Greeting Card Maker
This option provides information on Greeting Card Maker
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5
Frequently Asked Questions

Have questions? Read this chapter for answers to
users’ frequently asked questions.

General
Q. What kinds of cards can I print?
A. Greeting Card Maker supports several kinds of cards - some you can print on regular paper, and some you
can print on pre-printed card stock. The cards you can print on regular paper don’t require any special paper
or cardboard. These include the Quarter Fold cards and the Half Fold cards. Quarter Fold and Half Fold cards
can be printed in either portrait orientation or in landscape orientation.

Q. What are pre-printed card stock cards?
A. Pre-printed card stock cards are cards that you can obtain from different manufacturers that already have
designs printed on them. The cards featured in Greeting Card Maker are special cards, since they are blank
on the inside. You can create your own sentiments and graphics on the screen, then print your designs on the
real card.

Q. How do I order pre-printed stock cards?
A. On the Clipart bar there is a button labeled "Order Cards". Click here for information on each card manu-
facturer’s phone numbers, special ordering information, and other available products. Each card displayed on
the screen has manufacturer and item# information on the status bar. Be sure to have this information ready
when you are ready to place an order.
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Q. What’s the difference between portrait and landscape cards?
A. Portrait cards are viewed "upright" or taller than they are wider. Landscape cards are wider than they are
taller.

Using Greeting Card Maker
Q. How do I see the different card views?
A. The Navigator Bar is a small floating toolbar with four buttons on it. Pressing each of the buttons will switch
you to the indicated view.

Q. How do I change text? 
A. To change any piece of text, simply double-click on it with the mouse. The Edit Text dialog box will appear
where you can type and format the text.

Q. How do I import my own pictures?
A. There are two ways. The first is through a Menu - choose Insert/Clip-Art selection. A dialog box will appear
where you can browse through your directories and select the file you want to import. Greeting Card Maker
supports most popular graphics file formats. A preview of the highlighted file will appear in the Preview box.

Q. When I import my own 256 color pictures my screen colors get messed up?
A. This is a common problem when  Windows is configured to display only 256 colors and you have several
256 color images on the screen at the same time. Each image is competing for the color palette, and only one
can use all 256 colors at one time. We strongly recommend that you configure Windows to run in 16-bit color
(High Color) or higher, if your video card supports it. Please refer to your Windows User’s Guide or your video
card guide for information on how to configure Windows to display more than 256 colors.
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Q. I want to print on my own cards, how do I change the card dimensions in the program?
A. There is a dialog box named Card Setup, available through the Format menu. Here you can enter the new
dimensions for your card. Enter the height and the width of the card when folded, in other words, the size of
each card panel. You can also enter dimensions for envelopes which are not the standard size.

Q. Can I customize the sentiments?
A. You can edit, customize, and personalize sentiments just like you can any other text object simply by dou-
ble-clicking on it.

Q. What are Signature Symbols?
A. Signature Symbols are combinations of text and graphics that are usually found on the back of cards. You
may think of them as "trademarks" or "logos". In Greeting Card Maker, Signature Symbols are actually
grouped objects saved as .sym type files. You can create your own Signature Symbols by grouping your own
text and graphic, then saving them through the Edit/Save as Symbol menu. To use them again, click on the
Insert Symbol button on the left toolbar.

Printing
Q. Why do I need to configure Greeting Card Maker to work with my printer?
A. Printing on pre-printed stock cards requires that you correctly feed cards into your printer. The purpose of
the Configure Print dialog box is to setup the program with settings for your particular printer, including manual
feed operations.

Q. How do I feed the cards in for manual feed?
A. Whenever you print a Half Fold card or a Pre-Printed Card stock card, two-sided printing will be required,
that is, you will have to turn the page over and re-feed it into the printer so that you can print on the other side.
A dialog box will appear with a graphic indicating how to feed your card or paper into the printer. This graphic
will be based on information you provided in the Configure Printer dialog box, so it is important that these set-
tings are correct.
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Q. What if the cards don’t print right?
A. In the event that your cards don’t print out correctly, there are two main things you can try. The first is to
review your Printer Configuration settings. Make sure that the settings in this dialog box are correct for your
printer. In the event that the correct settings don’t seem to work, experiment with different settings and observe
the effect they have on your print-outs.

Q. The second thing you can try if your cards don’t print out correctly aligned on the card is to try the
Print Align function. Located in the File/Print Align menu, you can manually shift the card in the direc-
tion you want to align it in. A graphic displays the amount that you are nudging your design over.
A. Anytime you are printing on paper that is not standard size (greeting cards, for example), there are many
variations in the way different printer manufacturers deal with this issue. We have tried to include as many set-
tings as necessary in order to compensate for these differences. The best thing to try, whenever you are print-
ing on pre-printed cards, is to practice first by printing on a test card of the same size as your real card, and
observe your results.

Q. How do I fold quarter fold and half-fold cards?
A. There is a section entitled Folding Cards in this documentation. It contains diagrams showing how to fold
the different kids of cards, including 

Q. Some special text effects don’t print right. What’s Wrong?
A. Some printer drivers, including the Hewlett Packard Deskjet 660 series color printers have drivers that do
not support some of the Shape Text effects featured in Greeting Card Maker. We recommend that you contact
Hewlett Packard directly at their customer support phone included in your user’s guide and inquire as to newer
versions of their printer drivers.
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A
Appendix: Order Cards
Fintech Software

24 Cards for Only $16.80! 
PLUS

a bonus of 10 FREE cards and envelopes 
(a $7.00 value) 

Print your customized greetings on the colorful collection of pre-printed cards
featured in Expert Greeting Card Maker and Holiday Card Maker. Each card is
printed on quality paper stock and is custom designed to use with this program.
Blank Cards are also available to print your original designs on!  All cards are 4
¾" x 6 ¾" size and include matching envelopes.

(800) 272-7792
Fax (914) 923-4611

Mention Expert Software when you call, to get 10 cards and envelopes free!  (A $7.00 value), or mail your
order along with a check for $20.30 ($16.80 for purchase + $3.50 shipping) payable to Fintech Software.

Fintech Software Corporation
34 Ridge Road

Chappaqua, NY 10514

Greeting Card Maker features the Zillion Kajillion TM Rhyme Dictionary. For a demo of the commercial version of Zillion Kajillion Rhymes, please
check out the Zillion directory on this CD.
Don’t forget to include Expert’s clip art images in your Greeting Card Maker image library.

Greet.qxd  11/22/96 1:53 PM  Page 81



INDEX
C
Choosing a Ready-made Design
Configuring Your Printer
Constructing and Editing Your Own Cards
Creating a Sample Card

E
Edit Menu

F
File Menu
Folding Cards
Folding Half-Fold Landscape Cards
Folding Half-Fold Portrait Cards
Folding-Quarter Fold Landscape Cards
Folding-Quarter Fold Portrait Cards
Format Menu
Frequently Asked Questions

H
Help Menu

I
Insert Menu

L
Left Toolbar
License Statement

M
Main Interface
Main Toolbar
Menus

N
Navigator Bar

P
Printing
Product Support
Program Overview

S
Setting Your Preferences
Special Text Effects/Shaping Text/Adding Sentiments

T
Trademarks, Copyrights and Credits
Tutorial
Types of Cards

U
Using Signature Symbols
Using the Card Editor Screen

V
View Menu

W
Working With Images
Working With Text

Greet.qxd  11/22/96 1:53 PM  Page 82



Expert Software License Statement Expert Software License Statement 
This software is protected by both United States Copyright Law and International Treaty provisions. Expert Software, Inc. grants you this license
and your continued use confirms your agreement. Therefore, you must treat the software “just like a book,” with the following single exception:
Expert Software, Inc. authorizes you to make archival copies of the software for the sole purpose of backing up your software and protecting your
investment from loss.
By saying “just like a book,” Expert Software, Inc. means, for example, that the software may be used by any number of people and may be freely
moved from one computer to another, so long as there is no possibility of being used at one location while it’s being used in another. This is just
like a book that cannot be read by two different people in two different places at the same time; neither can this software be used by two different
people in two different places at the same time.
This agreement shall be construed, interpreted, and governed by the laws of the state of Florida and shall inure to the benefit of Expert Software,
Inc. its successors, administrators, heirs, and assigns. 

u 

u Limited WLimited Warrantyarranty
Limited warranty on product disks. To the original buyer only, Expert Software, Inc. warrants the disk or disks on which this product is recorded
to be free of defects in material and workmanship under normal use for a period of 90 days from the purchase date. Any implied warranties of mer-
chantability or fitness for a particular purpose are limited in duration to the period of 90 days from the date of purchase. Your sole and exclusive
remedy in the event of a defect in material or workmanship under normal use is expressly limited to replacement of the defective item.
This warranty gives you specific legal rights, and you might also have other rights which vary from state to state.
No warranty on product software or User’s Guide. Even though Expert Software, Inc. has tested the software and User’s Guide and reviewed their
contents, Expert Software, Inc. and its distributors and dealers make no warranties, either expressed or implied, with respect to the fitness for a
particular purpose. The software and User’s Guide are distributed solely on an as is basis. The entire risk as to their quality and performance is
with you. Should either the software or User’s Guide or both prove defective, you (and not Expert Software, Inc. and its distributors and dealers)
assume the entire cost of all necessary servicing, repair, or correction. Expert Software, Inc. and its distributors and dealer will not be liable for
direct, indirect, incidental, or consequential damages resulting from any defects in the software or User’s Guide, even if they have been advised of
the possibility of such damages.
Some states do not allow limitations on how long an implied warranty lasts or the exclusion or limitation of incidental or consequential damages,
so the above limitations or exclusions might not apply to you.

u 

u CopyrightCopyright
© 1996 Expert Software, Inc. All Rights Reserved.  All Rights Reserved Worldwide. The user’s guide and the software described in it are copy-
righted with all rights reserved. The user’s guide or software may not be copied in whole or part, without written consent of Expert Software, Inc.
You may not sell, rent, lease or transfer copies of the user’s guide or software in any other way without the prior written consent of Expert Software,
Inc.

u 

u TTrademarksrademarks
Expert Software and the Expert brand logo are trademarks of Expert Software, Inc. Microsoft and Windows are registered trademarks of Microsoft
Corporation. Macintosh is a registered trademark of Apple Computer Inc. All other trademarks are acknowledged.
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Product SupportProduct Support
Your purchase of an Expert product includes free product support to help you get the most out of your software. All Expert products are thoroughly
tested and come with a Help File, User’s Guide and/or Online Manual. In most cases, the answers to many of your questions are in the Help File,
User’s Guide and/or Online Manual. If you are having problems starting or running the program, please feel free to contact us. 

24 Hour Automated Support24 Hour Automated Support
u  u  Find answers to frequently asked questions on the worldwide web at http://www.expertsoftware.com
u  u  Use our Fax Back System by calling (800) 772-5706 from your touch tone phone."

E-mail AddressesE-mail Addresses
u  u  You can send e-mail to support@expertsoftware.com or sales@expertsoftware.com

Mailing AddressMailing Address
u  u  800 Douglas Road, Coral Gables, FL 33134 or P.O. Box 144506, Coral Gables, FL 33114-4506.

TTelephone Product Supportelephone Product Support
(  Contact a friendly Expert Product Support Specialist Monday through Friday, 9:00AM to 5:00PM EST (Eastern Standard Time). 

u  u  Telephone (305) 567-9996
u  u  Fax (305) 569-1350.

If you call, you should be at your computer. Be ready to give the Product Support Specialist the 10-digit program version number from the front of
your program disk or back of the CD jewel case, as well as the following information:
u  u  If you have a Macintosh®–compatible computer:

u  u  Please have the model, system software version and amount of memory available.
u  u  If you have a Windows®– or MS-DOS®–compatible computer:

u  u  The version of DOS that is installed on your computer. (You can determine the version by typing VER at the DOS prompt.)
u  u  The version of Windows® installed on your computer.
u  u  The type of hardware you are using:
u  u  The brand of computer you own, 
u  u  CPU type (80386, 80486, Pentium®), 
u  u  Video type (EGA, VGA, Super VGA),
u  u  Model and type of video card, and 
u  u  Model and type of printer.
u  u  The exact wording of any messages that appeared on the screen.
u  u  What happened and what you were doing when the problem occurred.
u  u  We encourage Windows® 3.x (or MS-DOS 6.x) users who need product support to print an MSD report. Have it available for the

Product Support Specialist who answers your call. You will find the MSD (Microsoft Diagnostics) program in either the Windows or
the DOS directory.
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